Cityof
SACRAMENTO

Community Development

Electronic Plan Check (EPC)
Building Permit Submittal Requirements

Submittals do not become active plan check activities until payment is received.

Beginning with Cycle 2, all design professional stamps must be signed and limitations like “Not for

»n «u

Construction”, “Preliminary” or “Bid Set Only” may not be present on plan sheets.

All file uploads must be made to SUB- records.
It is not possible to upload files directly to COM-, RES- or MP- files.
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Introduction:

To reduce paper waste and the expense and inconvenience of printing multiple copies of construction
documents required for a building permit application the City of Sacramento has developed the Electronic Plan Check
Program (EPC).

Applicants participating in this program condense their submittal package into three bookmarked PDF files the
contents of which are discussed in detail below. Submittal of these three files can be made remotely through the
Citizen portal (http://aca.accela.com/sacramento) or at the public counter (300 Richards Boulevard). Regardless
of your method of submission all applicants will need to register for a basic Citizen Portal account.

A full detailing of general plan review requirements can be found on our website under Plan Review and then
Plan Preparation. For an Electronic Plan Check specific pre-submittal checklist, go to Plan Review and then
Electronic Plan Check. All files must be named according to the naming standards outlined under File Naming
below.

Please note: All EPC submittals go through the same standard review process as hardcopy submittals. Submitting
an EPC does not constitute an expedited review. Applicants may check the status of an electronic or hardcopy
application through the online portal at https://aca.accela.com/sacramento/Default.aspx

Questions about any of the information contained in this document may be directed to Building Division staff
at epcintake@cityofsacramento.org .

Electronic Plan Check (EPC)
It is Easy

Instead of construction

plans, application and

support documents on
paper you submit the same

1. APP file: )»(2. PLANS file: }CS. SUPP file:
materials inthree separate ? ? ®

'
PDF files. 0 ’ ]
'

Files can be
submitted online by
creating a Planning
Application for
clearance to submitto
Building

,--o' ¢
o

. ¢

Construction Plans
T-24 Energy compliance
Documents.

L]
S
S

.---------.
@ecccccccnas

~

As needed:

e  Building Permit Application CDD-
0200

Planning Referral Sheet or Approved
Exemption Form

Authorization for Owner -CDD-0204
Address Request Form CDD-0104

Version 27

/As needed:

Structural Calculations

Fire Sprinkler Calculations and Cutsheets

Soils Reports

Geotechnical reports

Truss Calculations

Water Supply test

Special Inspection Form CDD-0197

Accessibility Upgrade Requirements CDD-

0201

e Site Drainage and Encroachment
Questionnaire CDD-0227

e  Owner Certification of Residential Lot Lines,
Building Location, and Required Setbacks

CDD-0252 /

Revised 2/12/2020

Materials required for
approval are the same
for both processes. The
electronic process simply
involves PDF file
submission instead of
paper.
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Submitting On-Line:

To submit your application remotely you will need to begin the submittal process by setting up a basic account at
the CDD Citizen Portal. This will enable you to submit your EPC application through the portal. The Online
Submission Demonstrated section in this guide provides step by step instructions with visual representation of the
process.

The first step is to create a Planning Application Submittal (PLN) record to receive clearance from planning to
submit your plans to building for Electronic Plan Check (EPC). If planning determines that the project already has
an approved planning entitlement or does not require one, your application will be deemed Ready for Building
and a SUB record will be generated for you to continue the application process with your building plan review.
You will receive an email notification when of your clearance to submit to building and of any items still required
to be submitted. If your files meet the submittal requirements outlined in this guide when submitting your Online
Planning Application, building staff will be able to accept your submittal without the need to request content or
formatting changes and proceed to create your building permit application. Once your materials are deemed to
be a complete submittal package, a building permit record (COM-, RES-, FPP or MP-) appropriate to the projects
scope of work will be initialized in our permit management system. Within this record, submittal fees will be
calculated and invoiced and then emailed to the applicant for payment. Once payment of this invoice is made the
project will formally enter plan review.

It is important to retain the SUB- record number which will be emailed to you when your project receives
clearance from planning. This record (the SUB-) will be used to resubmit revised files as you go through plan
review, and are given plan review comments.

Even after you are assigned a COM-, RES- or MP- number continue to upload revised plans which are in response to
plan review comments to the original SUB- file. There will always be a one to one relationship between SUB- record
numbers and COM-, RES-, FPP- or MP- records, so if you apply for a building permit and then apply for phased permits
under that main permit you will need to submit each phased permit application separately through the portal. This
principal also applies to revisions proposed to an issued permit. If you have an issued permit and wish to apply for a
revision to that permit you will need to submit that separately through the portal and in doing so you will be assigned a
new SUB- record number for that revision after receiving planning clearance.

The following page contains a visual representation of how EPC submittal works.
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Submission begins

Citizen Portal

Applicant creates
Planning Application
Submittal (PLN) &
submits their APP,
PLANS and SUPP
files through the

Citizen Portal

Planning Clearance

City Planning intake
staff reviews submitted
files to determine ifan
Entitlement is needed &
clears the submittal for
Building (SUB-record is
created for applicant &
email notification sent
with next steps).

Submission Complete

Staff targets all
appropriate plan review
disciplines and project is
moved from Applied to
Plan Check Target.

Cycleone
plan review
concludes

Version 27

How EPC works

Applicant registers
for a Basic Citizen
Portal Account.

Building Review of Submittal

-~

(
!

City Building Intake staff

O reviews submittal package in @

the SUB- record.

Incomplete
submittal

Incomplete submittals are sent
a submittal correction notice.
Complete submittals move
forward in the process.

Complete
submittal

Staff creates
a building permit record using
the appropriate
record type, calculates
submittal fees, and emails the
applicant requesting

payment.

Applicant
pays the submittal
fee invoice on the
COM-, RES-, FPP-
or MP- record.

Cycle one plan
review correction
o~
comments
received

Cycle two resubmittal uploaded to._
original SUB- record on-line

—

All plan review

disciplines @==jjp- On t0 processing and issuance
approved
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File Contents Detailed:

As illustrated in the flowchart above there are three primary PDF files which are used to convey all EPC
submittals. These files are the APP, PLANS and SUPP file. There is one other file which plays a significant role.
This file is the REPLY file. This file is only needed in cycle two and beyond because it contains reply/response
comments to the plan reviewers.

Your initial submission will be comprised of an APP, PLANS and SUPP file. In subsequent plan review cycles only
files which needed modification (due to plan review comments or changes) along with a REPLY file will need to
be resubmitted.

Resubmissions to plan review comments (Cycle two and beyond) will most often be comprised of a PLANS, SUPP
and REPLY file. Only in cases where the APP file needed revision or augmentation will a new APP file be required.

The following paragraphs detail the content of each distinct PDF file. Applicants must submit on-line or at the
public counter. If submission is made at the public counter the files should be supplied to counter staff with one
(1) CD, DVD or thumb drive which contains no more than the maximum four PDF files.

Application (APP):

The most important core documents contained in the APP file are the Universal Building Permit Application (CDD-
0200) and the Planning Referral Sheet (PR) if one was provided. The application can be found online at the City of
Sacramento’s website at http://www.cityofsacramento.org or by following this link app. Note that the Planning
Referral Sheet (PR) is being phased out and replaced with a Planning Approval stamp on all building submittals with
the launch of the e-Planning services. Questions regarding the Planning clearance to submit to building can be
emailed to Planning staff at planning@cityofsacramento.org.

In general, the APP file should contain any City form necessitated by the scope of your project. Common
documents or forms which fall into this category are:

=  Building Permit Application (CDD-0200): Application for a building permit.

= Agent Authorization for Owner (CDD-0204): Required when an individual will be
representing the recorded real property owner.

=  Agent Authorization for the Contractor (CDD-0196): Required when an individual who
does not appear on the Personnel List posted on the California Contractors State License
Board website is representing said contractor in the pursuit of a building permit. With this
form completed, an individual is authorized as an agent of the contractor.

= Address Request form (CDD-0104): Necessary if the scope of your building permit will
require the creation of a new street address.

= Planning Referral Sheet (PR) or Planning Exemption Forms when provided by Planning:
Conveys the Planning Division’s authorization for a project to submit to the Building
Division for a building permit. Planning may provide a signed exemption checklist instead
of a PR sheet. Note that if no PR Sheet or Planning Exemption Form is provided by
planning a planning stamp must be present on the construction plans. For more
information, see the section below titled “Planning Clearance to Submit to Building.”

Any forms requiring signature should be wet signed and scanned rather than electronically signed.
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Planning Clearance to Submit to Building:

All building permit submittals are reviewed by Planning staff to determine if the proposed work is consistent
with zoning and design requirements or if a planning application is required. Planning must clear a project to
submit to building for plan review. Building permit applications can now receive planning clearance to submit
to building EPC through the Citizen Portal by creating an Online Planning Application (PLN) record under the
Planning tab.

The minimum requirements to receive planning clearance to submit to building are:

1. Asigned concurrent review form (MOU) is required from your Project Planner if the project has
a concurrent planning application that is in progress.

2. Adetailed scope of work (interior and exterior) must be in on the cover sheet of the plans. If
you have approved exterior work: please include Planning Project file number, Design Review
approval and/or exemption approval.

3. Submit architectural plans only. This would include the Cover sheet with the scope of the work
proposed, Site plan, Floor plan(s), Building Elevations, Roof, and Landscaping plans. If
mechanical work is proposed, a mechanical floor plan is also required.

4. Plans must contain a licensed professional stamp.

5. Plans must be in PDF form only.

Additional planning forms:

You may have received a Planning Approval (PR) Sheet signifying clearance to submit to building in the past. This
form should be placed in the APP file. Planning will review this form and stamp the PLANS file.

Depending on the scope of the project, planning may also provide the following alternatives to approve the project
for building permit and plan review submittal:

e One or more Planning Exemption Forms and stamped construction plans (see item 4 above) with a
Planning Approval or Exemption Stamp.

e Planning Exemption stamp only on construction plans (see item 4 above) without providing a signed
Planning Exemption Form.

Note: In either instance, the plans stamped by the Planning Division must be incorporated into the construction plans
file (PLANS).

Please email the Planning helpdesk (planning@cityofsacramento.org ) if you have any questions on how to obtain
Planning Clearance and planning approval.
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Plans (PLANS):

The second PDF file is primarily comprised of the construction plans. Special care should be paid to the sheet index,
often on the cover sheet. This index should only bear sheets which are included in the submitted set, and all sheets
included in the set should be shown in this index. It is also necessary to bookmark each sheet included in the set. T-
24 energy compliance documents should be included as plan sheets per California energy code requirements.

Unsigned stamps from the architect and/or engineer will be allowed at the time of submittal. Although, if this option is
exercised it will be impossible for Cycle 1 plans to be approved for issuance. Beginning with Cycle 2 resubmittals, all
design professional stamps must be signed. Signature should be accomplished by placing an image which includes
the digital stamp and wet signature on each sheet.

The Green Building Checklist/information, located at: http://www.cityofsacramento.org/Community-
Development/Resources/Forms/Building-Forms/CALGreen-Building-Forms shall also be included on the plans.

To have a precise and timely estimate of final fees; the building area, occupancy group and construction type must be
provided on the title page of the plans.

Only resubmit complete SUPP files. See section titled When do | Resubmit and other details?

Supplemental (SUPP) Information:

The third PDF is the SUPP file. This file contains all required support documents. The following is a list of some common
support documents which would be included in the SUPP file. Not all of these documents are required for every project.
The scope of the project dictates their need:

e  Fire Sprinkler Calculations

e  Fire Sprinkler System component cut sheets
e  Structural Calculations

e Soils Reports

e  Geotechnical reports

e Special Inspection form CDD-0197 (only required in resubmittals)
e  SWPP Storm Water Pollution Plan

e  Water Study (usually subdivisions)

e Sewer Study (usually subdivisions)

e Drainage Study (usually subdivisions)

e Water supply test

e Project Manuals

e Technical Specifications

Site Drainage and Encroachment Questionnaire CDD-0227 (residential 1-2 units only)
e Owner Certification of Residential Lot Lines, Building Location, and Required Setbacks CDD-0252
(residential 1-2 units only)

Only resubmit complete SUPP files. See section titled When do | Resubmit and other details?
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Plan Review Response Letter (REPLY)

After each cycle of plan review, each discipline (i.e. electrical, life-safety, etc.) plan reviewer will either approve
the submitted PLANS and SUPP in their current form, or they will issue a correction notice which details areas of
your application (APP, SUPP or PLANS files) which require revision and resubmission. When resubmitting plans
revised to satisfy plan review comments, plans must be accompanied by a plan review response letter
addressing each correction comment. All alterations must be clouded, delta’d and in the same format and scale
as the original submission.

Accompanying this letter should be a complete Plan Review Resubmittal (CDD-0270) form. Note that without
this form your cycle 2 and beyond resubmittal package cannot be accepted. This package (letter and CDD-0270)
comprises the REPLY PDF file. In most cases, it will take the place of the APP file which was submitted in the first
cycle, but if changes or additions have occurred to the APP file then it must be resubmitted also. This makes it
possible for there to be four PDF files each cycle after the first.
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Submittal File Standards:

All digital files must comply with the following standards. Any deviation from the standards contained in
these instructions may result in a delay in the processing of your application.

In this section you we will detail those file formatting requirements which we are unable to correct for you,
and those, which our staff may be able to complete for you at intake. Those formatting requirements which
we may be able to correct for you are displayed in green font. Note that if all of these file formatting
requirements are fully completed by the applicant, our staff is able to accept your submittal faster and your
upload time will also be reduced.

All files to be PDF:

All digital documents shall be in Portable Document Format (PDF) and compatible with Adobe Acrobat 10 or
newer, refer to the Compatibility section below for more details on minimum versioning.

File Size:

Ideally each PDF file will not exceed 400MB in size. The system can handle files of larger size but upload and
download of these larger files may take significantly longer time spans. Also bear in mind that having a reliable
high-speed internet connection becomes increasingly important as file sizes increase.

Within Acrobat 8, select “Save As” then “Optimized PDF”, settings “Mobile” with a “Make compatible with:”
Acrobat 10.0 or later. This process is detailed in a separate section below.

Plans to be vector based PDF's:
PLANS files shall be first generation vector based PDF’s which have been directly converted from the computer
aided drafting (CAD) applications (e.g. AutoCAD, ArchiCAD, MicroStation, TurboCAD etc.) in which they were

created. Scanned Plans (i.e. plans, elevations, sections, details) will not be accepted unless the plan sheet was
hand drawn.

Scale:

PDF exhibits must be generated at a prescribed scale (i.e. 4” = 1’-0”, or 1/8” = 1’-0”) in order for staff to verify
dimensions and areas within the file, using the built-in Acrobat measuring tool. Graphic scales may also be
included, but are not required.

Page Orientation:

Page Orientation: All plans must be oriented so the top of the page is always at the top of the monitor, and set to
landscape. A north arrow must be provided on all plans. All supplemental information must be oriented so the top
of the page is always at the top of the monitor in either portrait or landscape format based on the supporting
documents provided. All supplementalinformation must be sized at 8-1/2” x 11” or 11”x 17”.
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Security:

PDF document security settings must allow staff to mark up the PDF file, and create comments. No electronic
signatures should be used on forms or drawings. Electronic signatures restrict security settings. Licensed
professional stamps should be digital stamps produced through Annotations or Drawing Markup tools.

The following PDF document contains an electronic signature which has locked the file from further alteration such
as insertion or merging into another PDF document. We cannot accept PDF files which are locked. The gold padlock
icon indicates the file is locked. This will prevent us from stamping your plans approved, encrypting the final
approved files or merging the file with other approved documents.

11 2012MeerWay-CYC1-SUPP3380467.pdf - Adobe Acrobat P/é
|| File Edit ‘View ‘Window Help /

| Beee- BB [ /]

R44989350.Q150254.PDF

=E |ovout | i= Files |

Re: 0150254
Q150254
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Adobe Acrobat Portfolios

We do not accept files submitted in Adobe Acrobat Portfolios. Portfolios enable multiple PDF files to be organized
into a “Portfolio”. The use of Portfolio does not conform to our submittal requirements which limits submissions to
three or maximum four (resubmission only) PDF files. Below is a screenshot of what an Acrobat Portfolio looks like.
You can see that contained within this one Portfolio is four separate PDF files. In fact to access the files you have to
select the open file which further shows that upon opening a Portfolio you haven’t really opened “a file”.

One of the reasons why applicants will often submit PDF files packaged in a Portfolio is because they have been
supplied an electronically signed PDF file from one of their design professionals. Electronically signed PDF’s are
locked in a manner which makes itimpossible to insert the file into another PDF file. We require that all four of the
PDF files shown below be merged into one.PDF file, organized within by bookmarks for each of the separate
documents it contains. 4

Following the screenshot below is a screenshot showing an-electronically signed PDF file because of this signature
the file is locked.

.@2012MEErWay'CVCLSUPP!BMIpdv‘—%abEAcmbath N\ =@ = |

[ File Edit View Window Help / x

N6 e B E S P | [ | [mea] =oe | E—
A —

T v

D:Z

Structural Engineering, Inc.

Structural Calculations

Client: Rosemary Carlson

Project: Carlson Residence
2012 Meer Way

Sacramento, CA 95823
———— Date: July 22, 2015

Prepared By: Ayako Sawada

Table of Contents:

DesignCriteria . . ................. 1
Gravity Design . . ....... e 2
Foundation Design ... ........... .4
Lateral Design (Reference Only) ..6
Anchorage Design (Reference Only) . . 23
ﬁarF:s,a .
.;é&.- & OLUREEN
e G
= =y
Q sl
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X »*
N &7
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e
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= PHONE: 530-677-0900 » FAX: 530-677-0901
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Bookmarks:

1. Allindividual plan sheets shall be contained within one single PDF file. If your PLANS file exceeds 20 pages
in length, each sheet shall be bookmarked for easy reference during plan check and intake (See Example
1.0). The bookmark titles should include the sheet number and subject matter (i.e. Floor plan, Site plan,
erosion plan, etc.). See below instructions on how to combine multiple pdf files into one while also
creating bookmarks.

Ideally your pages are set to “Fit on full page to window view” prior to bookmark creation. This can be
achieved by selecting this icon on your tool bar:

Also see section below on how to assure your plans a set to fit page in Adobe Acrobat Pro at any time.

pi915_I_ST_SUB_PLANS.pdf - Adobe Acrobat Pro ) =]
File Edit Yiew Window Help *
Eﬂﬂreate'|@I%.|@@¢l@ﬂm@@@|®tb@>lav| (s Rq

15 7% {5 | . Tools ; Comment

Bookmarks

)

EE

| ®

ﬁ:F C5 Project Cover Sheet Rev 2
[TP coa.1 conditions of Appraval
[TP coa.2 conditions of Appraval
[[F cos.= conditions of Approval
E:F C1-Title2004 10-4-11-Model
[T co-motes

|:I:F C3-Survey

U:F C4-Erosion-Model

[P c5-Site-Plan

U:F CE-Grading-tModel

(TP cr-utility-Model

I[P 41.0 Dermolition Site Flan

I[P 41.1 Site Plan Revl

U:F 41,2 Self Serve Car \Wash Bays
Enlarged Plan Revl

N | =

X

42,0 Demolition Floor Plan
U:F A2.1 Car \Wash Floor Plan Revl
[[P a2-2-Model Reve
U:F A2.3 Door and Window Schedules

Revl
[TP 42.4 Kiosk Reflected Ceiling and Roof Zoors
Plans Revl TR Tl P R

U:F 42,5 Enlarged Restroom Plans and
Elevations Revl

E:F A3.1 Car \Wash Exterior Elevations
U:F A3.2 Kiosk Exterior Elevations

|:I:F A3.3 Exterior Canopy Elevations
U:F 44,1 Car Wash Building Sections ;[

Example 1.0
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2. All other support documents such as Title 24, Structural calculations, etc. shall be provided in one
consolidated PDF file under the SUPP designation See Example 1.1.

IR adobe Acrobat Professional - [915_I_ST_SUB_SUPP.pdf] 3 =10 x|
'?_.]Eile Edit Wiew Document Comments Tools Advanced Window Help ;lilil

2™ H = g @ s

m Create POF » %Commem & Markup = &7 Send for Review » =) Secure - g Sign

Formsz -

LY Toseect i & - | | [1) o

= |?5% - @ ‘ [

Y!'|

l@ Help =

| This document contains interactive Form fields,

™ Highlight Fields

T EE 3= options - x

[ Title 24 Calculations =
E Structural Calculations
=H=] Fire - Cut Sheets
@ Sprinkler Head
@ Threaded Mechanical Branch
@ Threaded Mechanical Branch Instruct
@ Adjustable Hanger
@ Straight Tee

E Comments \ng Model Tr# Pagi Signatureli Bookmarks

tqco Fire & Building

Products

Technical Services: Tel: (800) 331-8312 / Fax: (200) 7E1-3500

Series TY-FRB — 2.8, 4.2, 5.6, and 8.0 K-factor
Upright, Pendent, and Recessed Pendent Sprinklers

Quick Response, Standard Coverage

General
Description

The Tyco® Series TY-FRB, 2.8, 42,
5.8, and 8.0 K-factor, Upright and Pen-
dent Sprinklers described in this data
sheet are quick response - standard
coverage, decorative 2 mm glass bulk
type spray sprinklers designed for use
n light or ordinary hazard. commercial
occupancies such as banks, hotels,
shopping malls, etz

fained when exposed fo corrosive at-
mospheres, Although corrosion resis-
tant coated sprinklers havefassed tive
standard comosion tests of the appli-
cable approval agencies, the testing is
not representative of all possible cor-
rosive atmosgheres. Consequently, it
is recommended that the end user be
consuited with respect to the suitabilty
«of these coatings for any grven cormo-
sive environment. The effects of

i~
ent temperature, concentration of
chemicals, and gasichemical veloci

L=

should be considered. as a minimum,

.y|

i

8.50 % 11.00in <
.| 1of1s >

-
4 | | 3 e

|
N an
LAl =

Pl | ©

Version 27

Example 1.1

3. Minimum “section” bookmarks required within the Supplemental (SUPP) Document PDF file shall be as
follows.
0 Fire Sprinkler Calculations
O Truss Calculation (if a trussed structure)
0 Structural Calculations

Note: Individual pages do not need to be bookmarked in the APP or SUPP files, only the sections
need to be bookmarked.
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How to combine multiple pdf files into one pdf with bookmarks:

This section is intended to provide you with one of the simplest ways to create bookmarks in your pdf files. When
working with your design professionals (architect, structural engineer, etc.) request that they provide you with a pdf
file which is bookmarked and also set to fit the screen. Most CAD programs already have a built-in feature to create
bookmarks based on sheet naming (e.g. A0.01 Floor Plan, A0.02 Demolition Plan, etc.). When you receive your
various bookmarked pdf files, you can simply combine them using Adobe Acrobat Pro as shown below.

In this example each pdf file is already bookmarked by the design professional. You only need to save these files into
a file folder and then combine them into a single pdf file.

L AL (LTS 1] [y TN

» EPC FILE EXAMPLES = PLANS

Mame " Date modified Type Size

E] Architectural 5/19/2077 8:19 AM Adobe Acrobat D... 13,093 KB
E] Electrical 5M19/2017 848 AM Adobe Acrobat D... 3,657 KB
'E] Fire Protection 5192017 8:32 AM Adobe Acrobat D... 1,994 KB
'@ Mechanical 5/19/2017 8:30 AM Adobe Acrobat D, 2,2T0KE
'@] Plurnbing 51972017 8:31 AM Adobe Acrobat D... 2,282 KB
'E] Structural 5/19/2017 8:28 AM Adobe Acrobat D... 6,674 KB

Simply highlight each file by clicking on the first file while holding down the “Shift” key on your keyboard and select
all files, then right-click to display the option to combine these files into one:

» EPCFILE EXAMPLES » PLANS

S

Mame Date modified Type Size
Eal] Architectural 5/19/2017 &19AM  Adobe Acrobat D... 13,093 KB
E] Electrical 3/19/2017 242 AM  Adobe Acrobat D... 3,657 KB
E Fire Protection 5/19/2017 8:32 AM  Adobe Acrobat D... 1,994 KB
E Mechanical 5/19/2017 8:30 AM  Adobe Acrobat D... 2270 KB
@ Plumbing 5/19/2017 8:31 AM  Adobe Acrobat D... 2,282 KB
ta:] Strug T k28AM  Adobe Acrobat D... 6,674 KB
Open with Adobe Acrobat XI
Print
‘@ Move to OneDrive
Ty Combine files in Acrobat...
Ea Scan with Windows Defender...
1= Share
Give access to >
Send to )
Cut
Copy

Create shortcut
Delete

Rename

Properties

Once you select the “Combine files in Acrobat...” option, the following dialogue box appears:
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(Do not select “Combine Files” yet if your files are not in the right order!)

» EPC FILE EXAMPLES » PLANS

~

MName Date modified Type Size
@Archi‘tectural 5/19/2017 819 AM  Adobe Acrobat D... 13,098 KB
T Electrical 5/19/2017 848 AM  Adobe Acrobat D... 3,657 KB
E] Fire Protection 5/19/2017 &:32 AM  Adobe Acrobat D... 1,994 KB
E Mechanical EAGMANT 0,20 ARA fdakhe A ot M 1IN KR
@ Plumbing Combine File - U =
@ Structural . an ==
(&5 Add Files... i = Opticns Help
MName Page Range Size Modified Bookmark for File Warnings/Errors
Eﬁrchitectural.pdf All Pages 12.79 MB 5/19/2017 .. Architectural
EEIectrical.pdf All Pages 3.57T ME 5/19/2017 ... Electrical
EFire Protection.pdf All Pages 1.95 MB 5/19/2017 ... Fire Protection
EMechanical.pdf All Pages 222 MB 5/19/2017 ... Mechanical
Eplumbing.pdf All Pages 2.23 MB 5/18/2017 ...  Plumbing
EStructuraI.pdf All Pages .52 MB 5/19/2017 .. Structural
< / >

Combine Files

Cancel

Prior to executing this option, you will also be able to move the order of these files, if necessary, to match how they
are listed in your sheet index. To move files around simply click on the file name which should be either moved up or
down in the order it is displayed, and the corresponding arrow below the files will turn into green as shown below.

E@ Combine Files

[ &5 Add Files... v

Mame
Ehrchitectural.pdf
%5 Electrical.pdf
EFire Protection.pdf
EMEchanical.pdf
4 Plumbing.pdf

Page Range
All Pages
All Pages
All Pages
All Pages
All Pages

tructural. pdf All Pages

Version 27

Revised 2/12/2020

ESJ Combine Files

[ &5 AddFiles...

Mame
Ehrchitectural.pdf
24 Structural. pdf

75 Electrical.pdf
ﬁFire Protection.pdf
EMEchanical.pdf
5 Plumbing.pdf

Page Range
All Pages
All Pages
All Pages
All Pages
All Pages
All Pages

I=>
<l
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Once your files are arranged in the correct order, simply select the “Combine files” option. This will result in all of the

individually bookmarked pdf files being combined into one pdf with nested bookmarks for each individual discipline

as shown below. Remember to save this file by selecting “Save as” under “File” and naming the it according to our

File Naming Convention requirements discussed in the following chapter below:

@ My_Masterplan-CYC1-PLANS.pdf - Adobe Acrobat Pr

Edit View Window Help

E Open | @ Create ~ ‘

B e e & X| &

@) [1]ree| v T | (= @

(e ]| A S
4

= Open...

@ Bookmarks E m

L—\P B~ moE
— | WP Architectural

& P 1 7-1Title

iF 2 AN-1.0 Notes

i? 3 AN-1.1 Notes Com

iF 4 AN-1.2 Notes Com

iF 5 AN-1.3 Notes Com VOC
iF 6 AN-1.4 Notes Res

P 7 AN-1.5 CoA

i? 8 A-1 Site Plan

i 9 A-2 Fir FI Plan

iF 10 A-3 Sec FI Plan

B 11 A-4 Third FI Plan

iF 12 A-5 Sec Third FI RCP

Save As Other...

Save To Acrobat.com...

@ My _Masterplan-CYC1-PLANS. pdf - Adobe Acrobat Pro
Edit View Window Help
Ctrl+0
Open From Acrobat.com...
2
Ctrl+5

Send File...

[£7 Get Documents Signed...

Revert

Close Tl+W

Properties... /CtrI+D
& Print... / Ctrl+P

View All Recent Files...

i 13 A-6 Roof Plan
i 14 A-7 Elev

P 15 A-8 Elev

iF 16 A-9 Sections

2 ChUsers\..\pcbp-ReportWriting Tips.ps
3 C:.\April 2013 Monthl.. trative Repol
4 C:..\Master List of Fe... Units 3-15-19.pdf

5 C:LAFINAL Master Zero...9 (version 4)_.pdf

i 17 A-10 Sections
P 18 A-11 Stair
i 19 A-12 DW Sched
i? 20 A-13 Int Elev
i 21 A-14 Finish
iF 22 A-15 Details
iF 23 A-16 Details
i? 24 A-17 Details
P 25 T-24.1

P Structural

=P Electrical

=P Mechanical

= P Plumbing

=P Fire Protection

Version 27

L save As
« v 4 » ThisPC » Desktop » SUBMITTAL
Organize v New folder

v g Quick access
[l Desitop
* Dewnloads
|4] Documents
= Pictures

CDD 2013 EPC Stamps ~

Exit /

Ctrl+Q

Date modified

[T T 1 - FIRST-ST-CYC1-PLANS
L L

Save as type:  Adobe PDF Files (*.pdf)

Settings...

» Hide Folders

Il

Save to Online Account =

Cancel

Revised 2/12/2020
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How to set your PLANSs file to “Fit Page” in Adobe Acrobat Pro:

This section is intended to provide you with instructions on now to assure that each page of your plans file will open
to fit the user’s computer screen regardless of the size. There are other methods to assure that your files are set to
fit the page, however, if some of your design professionals provided you with plans which did not contain this setting
and the document already contains bookmarks, this method will assure that the entire document will be set to this
setting.

Once your PLANS file is assembled and contains all the required bookmarks, open the bookmark pane and highlight
all of the bookmarks within a nested bookmark section by holding down the “Shift” key and highlighting every
bookmark. The next step is to right-click for a dialogue box to appear. Select “Properties” and then the “Actions” tab.
You will choose the “Add” button which will open a “Menu item” window. Select the “View>Zoom>Zoom to Page
Level” and click “OK”. See steps below:

'EI My_Masterplan-CYC1-PLANS. pdf - Adobe Acrobat Pro
File Edit View Window Help

—] Open |@Create' ||_|@% @|

$) |6 fﬁg| Ik @ | - (o) [ 748% [+ | ECIickonthe”Bookmark”iconto

*
open the Bookmark panel.
| | Bookmarks
E" IE II‘ Then open a section of bookmarks

[ B B and highlight all of them using the
“Shift” key.

- [P Architectural
Qé, W structural Right-click to open a dialogue box

; below and select “Properties”
[P Electrical P

=P Mechanical
uf_,ﬁ' =P Plumbing
=P Fire Protection

P Fp1 N\
TP Fp2 |
H:F EFPZ-‘I | Go to Bookmark
H:F FP3 | Print Page(s)
qu FP2.1 | Print Section(s)
iy FP4 | Cut Ctrl+ X
TP FP4.1 I D
Delete Page(s)
u:F g
i J Extract Page(s)
Eename
Use Current Appearance as New Default
fv Wrap Long Bookmarks
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Bookmark Properties > When the “Properties”
. option is selected as
Appearance Actions .
shown above, you will
Add an Action see another dialogue
SeectAction : box open with two
oy tabs: “Appearance”
Add... and “Actions”.
Actions Click on the “Actions”
Go to a page in this document tab” then “Add”
Up Down Edit Delete
Menu Iterm *
Edit> Check Spelling>In Comments, Fields, & Editable Text... »
Edit>Find
After selecting the “Add” option, the Edit>Advanced Search
“ » wind il Edit>Preferences...
Menu Item” window wi appear. View=Page Mavigation=First Page
View=Page Mavigation>Previous Page
Select the “View>Zoom>Zoom to Page View>Page Mavigation>Next Page
Level” option as shown and select “OK” View>Page Navigation> Last Page
' View>Page Mavigation>Page...
L View=Page Navigation>Previous View
Once you save your pdf all pages within View>Page Navigation>Next View
this section are now set to fit the page! View>Page Display>Single Page View
View=Page Display=Enable Screlling
View=Page Display>Two Page View
View>Page Display>Two Page Screlling
View=>Zoom>Zoom To..
View>Zoom> Actual Size
View>Zoom>Zoom to Page Level
View>Zoom:>Fit Width
View>Zoom:=Fit Height
View>Zoom:=Fit Visible
View=Portfelio>Preview File
View>Portfolio: Layout
View:=Portfelio>Details
View=Portfolio= Cover Sheet <
Cancel
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Compatibility:
The process described above under File Size must be followed to ensure the PDF files are as small as possible, and

compatibility with the City’s process. To verify that your files are saved in an appropriate compatibility open in
Acrobat 10 (also called Acrobat X) or Acrobat 11 select File, and then Properties.

@ MP-1820006-CYC1-PLANS.pdf - Adobe Acrobat Pro

Version 27

Edit View Window Help

& geen.. I egeB R
Open From Acrobat.com...
L L il
@C[eate ’B‘mm‘&
: Save Ctrl+S
Save As... Shift+Ctrl+5
Save As Other... L4
Save To Acrobat.com...
Send File...
[£7 Get Documents Signed...
Revert
Close Ctrl+W
= Print... Ctrl+P
View All Recent Files...
1 C:A\Users\..\MP-1820806-CVC1-PLANS. pdf —
2 Ci.\Building-Division...-February-2019.pdf
3 Ci.\Building Division...19 Cover Sheet.pdf
4 C..\Building-Division...bruary-2019-PP.pdf
5 ChUsers\whandley'..\R2017-0170 FY17-18.pdf
i tr+Q  \BBREVIATIONS
' e e P ZEra Fr
a AT Fl FLOOR LIST atn il
. BaLETERGR RouRD Hilis FUERE o B
o vl Fior: Flitrescent T P
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This will open the Document Properties window. Within this window select the Description tab. In the lower
portion of this window, in the advanced box, will be displayed the PDF Version which the file is currently
compatible with. Acrobat 10 or newer is ideal. This is the version shown-as 1.7.

Document Properties : . )\ -_AR Ge Nt "4 k S'rﬂi P4 .‘ =

Description ‘Security | Fonts |lnitial View | Custom | Advanced‘

Description

File: COM-1311679_JOBCOPY Plans

Title:

Author.

Subject:

|
|
|
Keywords:

Created: 12/24/2013 11:00:00 AM

Modified: 1/14/2014 11:53:41 AM

Application: Adobe Acrobat 10.1.8

Advanced
PDF Producer: Adobe Acrobat 10.1.8
PDF Version: 1.7, Adobe Extension Level & (Acrobat X)
Location:  C:\Users\goswell\Desktop\,
File Size:  60.72 MB (63,669,356 Bytes)
Page Size: 36.00x 2398 in Number of Pages: 58

Tagged PDF: No Fast Web View: Yes

o e

Below is an example of a file with older versioning.

Advanced
PDF Producer: Omnipage CaptureSDK V12.8 http://www.scansoft.com
PDF Version: 15 (Acrobat 6.x)
Location: UA\FEE MANUAL 20114SACRAMENTO TRANSPORTATION AUTHORITY FEE\
File Size:  5.01 MB (5,249,837 Bytes)
Page Size: 849x 10.88 in Number of Pages: 92

Tagged PDF: No Fast Web View: No

Version 27 Revised 2/12/2020 Page 22 of 58



To correct a file with older versioning so that it is compatible with version 10, with the file open in Acrobat 10
or 11 select Save As and then Optimized PDF.

{8 Edit View Window Help

% Open... Cul+0 [y [@ 8- By & | @ 2
5 Create 4
[Z) Save Ctrl+S
Save As PDF.. Shift+Ctrl+S
FiEED D Bl Reduced Size PDF...
Action Wizard ¥ | Certified PDF...
Revert Rea{:ler Extended PDF 4 am
Close CtrlsW Optimized PDF...
Properties... Ctrl+D Image ‘
Microsoft Word 4
& Print.. Ctrl+P | spreadsheet »
1 C\Users\..\400 CAPITOL MALLtest.pdf More Options 4
2 C\Users\..\COM-1312670-SUB2-PLANS[2].pdf s vVieasure A develo
3 CA\Users\..\COM-1311679_JOBCOPY_Plans.pdf - .
4 C..\COUNTER-PROCEDURE..NUAL 7-18-2014.pdf inistrative fee to fun
5 UASCANNED CODE BOOKS\MOTOR pdif ;lopment |mpact'fee
Exit -2 3lopment impact fee
I. : an administrative fee in order to rec

Within the PDF Optimizer window select Acrobat 10.0 and later in the Make compatible with box. Complete
the work in this window by selecting ok.

PDF Optimizer e
|| ]

Settings: Delete Audit space usage...
Current PDF Version: 1.5 (Acrobat 6.x) Make compatible with: | Acrobat 10.0 and later =

Retain existing
Acrobat 4.0 and later

Images Image Settings Acrobat 5.0 and later
Fonts Color Images : Acrobat 6.0 and later
[ Transparency Acrobat 7.0 and later
Discard Objects Downsample: |Bicubic Downsamplingto  »| (150 ppjfor images ak Acrobat 8.0 and later
Discard User Data Acrobat 9.0 and later
Clean Up Compression: [JPEG vl Quality: lMedium '] Acrobat 10.0 and later

Grayscale Images :

Downsample: | Bicubic Downsamplingto v | (150  ppifor images above |225  ppi

Compression: [JPEG 'l Quality: lMedium ']

Monochrome Images :

D ple: 300 ppi for images above 450 ppi.
Compression: [JEIGQ v] Quality: ||_055y v]

All units are in pixels per inch (ppi).

Optimize images only if there is a reduction in size

oK l [ Cancel

Selecting ok will open the Save Optimized As window. To complete the entire operation, you must select Save.
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X save Opflm St id A Bacibe - — _ X '
Savein | COM-1314641 - @1 @
»_ I Name - Date modified \
Y g X 1948 _SUTTERVILLE_RD_SUB_APP[1] 2/20/2014 11:53 AM !
RecentPlaces ™ 1945 SUTTERVILLE_RD_SUB_PLANS Cycle2 2/19/2014 8:38 AM
-| “X COM-1314641_PRO_PLANS 2/19/2014 1:30 PM 1
= “X COM-1314641_PRO.SUPP 2/19/2014 1256 PM *
Desktop “X proof of regional sanitation payment 2/21/2014 10:00 AM ]
u_d‘
Libraries
1&'
= .
Computer N
"
(]
«w |
< | T 3 .
Network '
FemEme COM-1314641_PRO_PLANS - "
L]
Save as type: Adobe PDF Files (* pdf) - I [ Cancel ]
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Layers should be flattened

When converting from the original CAD file to a Portable Document File (PDF), layers should not be retained in the
resulting PDF. This practice creates an excessively slow cumbersome file. To verify within Adobe Acrobat X (10) and 11
that the PDF PLANS file does not have layers, select the Layers tool located on the left side of the screen. There should
be no layers listed. If layers are shown select the options tool within layers and select Flatten Layers. The process of
Flattening can take a considerable amount of time. After Flattening, resave the file. After this process, when the Layers

tool is select no Layers should be listed.

ﬁ"} Create -

N e &b | oo & M

|
DO =00 MY | &

-

= r A S
Qw (] :+:
M

)

&

[
4

&©

e

Note that we will attempt to eliminate layers from your file, if they are present.

Version 27

Layers

=N

v List Layers for All Pages
1 List Layers for Visible Pages

Beset to Initial Visibility

Expand All
Collapse All

Bpply Print Overrides
Apply Export Overrides
Apply Layer Overrides

Import as Layer...

!ONS Lpdf

JON.pdf

Merge Layers...
Elatten Layers

Layer Properties..,

TION. pdf
N.pdf
N.pdf
N.pdf
N.pdf

C04.3 - HORIZONTAL CONTROL PLAN. pdf
C04.4 - HORIZONTAL CONTROL PLAN. pdf
C04.5 - HORIZONTAL CONTROL PLAM. pdf
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Checking for and Eliminating Comments:

In addition to checking for layers, files must be reviewed for the existence of comments. Submittal files should not
have any un-flattened comments. To check for the existence of comments click on the word, Comment in the upper
right-hand corner of the screen (in Adobe Acrobat Pro). The example shown below contains one comment. This file

must be flattened and re-saved.

There are two reasons for flattening comments. The first reason is customer security. In the example shown a
licensed professional’s signature is selectable. The second reason is that external comments have proven to cause

file stability problems within the city’s plan review environment.

Tools Fill & Sign Comment
4 8-

~ Annotations

SR T & @ &-
.22 I B

~ Drawing Markups

& —= @O
RGN A 4

+ Review

~ Comments List (1)

ro- B
& ipkouza - (|
Page 35 9/22/2016 1:57:50 PM

SIFICATION
C-16
LICENSE NO.
#783132

S DRAWING IS PREPARED BY FOOTHILL
. PROTECTION FOR ITS EXCLUSIVE USE
IS GUARANTEED ONLY WHEN FOOTHILL
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Here is an example of the comments area, of a file, where no comments remain. This is how an EPC PDF file should
look prior to submission. Note, after a file is opened and comment is selected it often takes a moment for the
comments to load. When checking for comments be sure to allow an adequate amount of time for the comments to
load.

Tools Fill & Sign Comment
&~

N Annotations

SZT &® &
Tﬁ%ﬁ%;%t:z

Bkl BE-IHES

¢ Drawing Markups

r Review

~ Comments List (0)
Q > o B-

This document has no comments.

Note that we will flatten these types of comments for you if they are present in a file. However, the next section
discusses a very specific type of comment which we are unable to flatten for you. These comments will appear to
be flattened when using a flattening tool, but they will continue to reappear when opened on another computer.
Please, review the “Autodesk AutoCAD SHX text comments” section below.
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Autodesk AutoCAD SHX text comments
Among the many types of comments which you may encounter the AutoCAD SHX text comment as shown below are

of significance.

Submitted PDF files must be free of these comments as we are unable to flatten them for you. Even when they
appear to be flattened using the standard Adobe Add-on flattening tool described in a section below, they will re-
appear once the document is opened on another computer.

The link below takes you to a discussion of this problem directly from the Autodesk website. There is an issue with
AutoCAD 2016 which causes comments to generate when SHX fonts are used in a drawing. This issue can be fixed by
the AutoCAD user by installing service pack 1 for AutoCAD 2016. This will allow the user to turn this behavior off
within AutoCAD. Alternatively, the AutoCAD user can stop using SHX fonts and use true type fonts which will not
produce this problem.

https://knowledge.autodesk.com/search-result/caas/sfdcarticles/sfdcarticles/Drawing-text-appears-as-Comments-
in-a-PDF-created-by-AutoCAD.html|

Customize - ‘ @

Tools Fill & Sign Comment

I B
__| = Annotations

PHTEB &
T. 2. & I B T

Submittal- 8-5-2015

» Drawing Markups

b Review

~ Comments List (3839)

Q 1 o~ B@-
B | AutoCAD SHX Text -
Page 12 Indeterminate
E

Wk

g | AutoCAD SHX Text ~
Page 12 Indeterminate
F

g | AutoCAD SHX Text -
Page 12 Indeterminate
D

g | AutoCAD SHX Text -
Page 12 Indeterminate
A

g | AutoCAD SHX Text -
Page 12 Indeterminate
L]

g | AutoCAD SHX Text -
Page 12 Indeterminate
C

g | AutoCAD SHX Text -
Page 12 Indeterminate
A J
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Flattening Tool:

The operation of flattening all comments in a PDF file is very simple. Unfortunately, though, Acrobat does not come
with a flattening tool out of the box. Search for “flatten page content tool” on the web and you will find a free
downloadable tool.

Once you locate and install the flattening tool you will be able to flatten and thus secure all comments and
annotations within your PDF file by clicking one button. If comments are not flattened they are vulnerable to being
inadvertently selected and deleted or altered by someone else working on the file.

Select the flatten tool. If this tool does not appear on the Quick Tool Toolbar go to Tools and then Add-on Tools. The
Flatten Pages tool is located under Add-on Tools. Right click this tool and select add to quick tool toolbar.

Tools Fill & Sign Comment

I

|| * Content Editing

» Pages

2K

ARCHITECTURE NG
Taas MW =OYT
FORTLAMD SREZOM PTIOY » Forms

» Action Wizard

» Interactive Objects

» Text Recognition

» Protection
~ Add-on Tools

_____________

LocalChapters
LocalChapterl?

E LocalChapterl5

s cecaowo0

Q19 DE DOT Development Engineering

APARTMENTS
l Eﬁ Flatten Pages

StampCopy

KK DEVELOFMENTS

10th Sf & O S

Add to Quick Tools Toolbar
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To flatten the file, select the Flatten tool = . The following dialog box will appear. Select the ok button. The
length of time necessary to execute this operation will depend on the number of comments being flatten. Once the
operation is complete, the file will need to be saved in its new flattened state.

.- Select Pages to Flatter

Select Pages to Flatten
Page range
@ All

i) Current

@) From:
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File Naming:

There are three distinct naming conventions that must be followed when creating the APP, PLANS, and SUPP
files for your initial submission:

1. Projects with an existing assessor parcel number (APN) and street address;
2. Projects with an existing assessor parcel number (APN) but no street address;
3. Master Plan projects.

Projects with an existing address:

The files must be named using the following simple naming convention:

1. XYZaddress-CYC1-APP
2. XYZaddress-CYC1-PLANS
3. XYZaddress-CYC1-SUPP

Projects with an existing assessor parcel number and no street address:

1. 000-0000-000-0000-CYC1-APP Usually zeros unless
2. 000-0000-000-0000-CYC1-PLANS a condominium
3. 000-0000-000-0000-CYC1-SUPP

The following shows how these files should appear when brought up on the city’s computer for uploading. For clarity
the sample address is 2816 Occidental Drive.

i e |

Organize « Include in library « \are with + Burn MNew folder

& - -
45% Favorites Mame Date modified Type

Ml Desktop [ 2816-0CCIDENTAL-DR-CYC1-APP ] 3/19/201510:12 AM  Adobe Acrobat D...

§ EPC 2816-0CCIDENTAL-DR-CYC1-PLANS 3/19/201510:12 AM  Adobe Acrobat D...
4 Downloads 2816-0CCIDENTAL-DR-CYC1-5UPP 3/19/201510:13 AM  Adobe Acrobat D...

= Recent Places

4| Libraries
> 3 Documents
» J‘r Music
> =] Pictures
> B Videos

) 3 items

Master Plan Projects:

The file names must be named using the following simple naming convention:
Bowling Green -Bldgl —CYC1-APP

1.
2. Bowling Green -Bldgl -CYC1-PLANS
3. Bowling Green -Bldgl -CYC1-SUPP

In the example, above, “Bowling Green” represents a model name; “Bldgl” represents a model number. Should the
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model name include several words, please, limit the file name to one or two words. For instance, “Bowling Green

Business Park” may be simply “Bowling Green”.

Please note that if you are submitting at the public counter the submittal disk must be physically labeled with the
project address, assessor’s parcel number, applicant name/info, and date submitted.

As a reminder, all files should be converted to PDF directly from their native or originating software files as opposed

to scanning of paper documents. Optical character recognized PDF files are required.

Cycle 2 and beyond Naming:

After your initial submission (Cycle 1) you will know the record number which has been assigned to your project. For

residential or Subdivision projects these record numbers will either have the COM, RES or MP prefix in front of a

seven-digit number. The naming convention for resubmission must then follow the convention below:

Or

A

P wNhPR

COM-1234567-CYC2-APP

COM -1234567-CYC2-PLANS
coOM -1234567-CYC2-SUPF?
COM -1234567-CYC2-REPLY

In-Fill or Production

°© O

Building Permits

MP-1234567-CYC2-APP
MP-1234567-CYC2-PLANS
MP- 1234567-CYC2-SUPP
MP-1234567-CYC2-REPY

Master Plan
°0O .
Review

Master Plan: A record number which tracks the review and approval of construction plans detailing a
structure to be built in the future within a specified development project. This process requires that the
structure be constructed a minimum of three times or more. Each individual structure is then authorized for
construction by individual Production Permits which review for site specific plan review criteria.

Production Permits: A permit authorizing the construction of a structure in conformance with an approved
Master Plan on a specific parcel or in a specific location within the specified development project it was
authorized for. Each production permit pays 50% of the plan review fees paid on a standard building permit.

In-Fill Permits: Generic term used to refer to building permits authorizing work related to structures which
are not part of a subdivision development or commercial campus development.

Definitions of Terms:
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When do I Resubmit and other details?

Once all the plan review disciplines required to review your application have completed their review you can
resubmit your revised plans for another review cycle. You will know that all disciplines have completed review when
the status of your COM-, RES- or MP- record is “Plan Check Wait”.

You resubmit to the SUB- record number. Even though your comments bear a COM-, RES- or MP- record number
you always resubmit or upload revised files to the SUB- record number.

Permit record status can be monitored at either of the two following web addresses:

http://sacramento.civicinsight.com (data is refreshed every few hours)
Or
http://aca.accela.com/sacramento (data is immediately refreshed)

To reduce the overall process time, separate corrections from each plan review discipline are sent to the applicant
immediately after each review is completed. This gives the applicant an opportunity to coordinate and forward the
City corrections to the appropriate design team member as soon as possible. However, you must coordinate your
design team response and resubmit a complete drawing set which responds to corrections from all the review
disciplines. EPC requires that a complete plan set be submitted for each cycle of review. This is one difference
between the paper process and the electronic process. In the standard paper process the city does allow a
resubmission to be comprised of only the sheets which required revision.

Revised plans are uploaded to the original SUB- activity which was created when you initially submitted your
application. Intake staff will be automatically alerted to your resubmission once your files have been uploaded. Refer
to the section within this document title, Resubmitting Your Submittal, Demonstrated, for step by step screenshots
of the upload process.

Beginning with Cycle 2, all design professional stamps must be signed. Signature should be accomplished by
placing a raster image of design professional stamps and wet signatures on each sheet which require them.

Mid plan review scope revisions which are voluntarily made by the applicant or the design team, and which do
not directly relate to plan review correction comments must be brought to the attention of the intake staff and
detailed in the response to plan review correction comments letter (REPLY file). Review of this kind of scope revision
will be performed at additional cost for one plan review cycle at the current staff hourly rate. Mid-plan review scope
revisions can also incur more significant fee changes and process changes which transcend simple additional plan
review costs. Therefore, good transparent communication with intake staff, project managers and plan reviewers is
of great value.

The “reply” document can be created in whatever fashion the customer wishes as long as it is legible, but will need
to be submitted to the City in a PDF format. Responses for each disciplines’ corrections shall be included in a single
PDF with the disciplines bookmarked.

Resubmittal files submitted via the Citizen Portal must be uploaded to the SUB- file which was used when making
your original submission. Refer to the Submitting On-Line section for more on this topic.

e Provide the revised files using the file name (provided at the top of each plan review correction). Standard
file format for resubmission is as follows:

COM-1001122-CYC2-PLANS

COM-1001122-CYC2-SUPP

COM-1001122-CYC2-REPLY (Cycle two and beyond)

COM-1001122-CYC2-APP (only necessary if changes or augmentations have occurred)

©O O0OO0Oo
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Note: “CYC2” in this example refers to Cycle 2 Submittal.

The Electronic Plan Response and Resubmittal process continues until all City corrections are satisfactorily
resolved.

Plan Review Resubmittal, File Preparation
Resubmittal packages should include a complete version of any of the electronic files (PLANS, APP or SUPP) which
required revision in satisfying plan review comments. Very often APP files never need revision throughout the plan

review process. For this reason, they often only need to be submitted in cycle 1. PLANS and SUPP files alternatively
often require revision. However, if the plan review corrections do not affect a file (SUPP or PLANS), it should not be
uploaded when resubmitting for a new plan review cycle.

As an example, let’s take the resubmittal of a SUPP file. If in cycle 1 due to the scope of your project you submitted a
SUPP file comprised of a soils report, fire sprinkler calculations and structural calculations. Cycle 1 plan review
comments required revision of the fire sprinkler calculations. The cycle 2 resubmittal should include the original soils
report, revised sprinkler calculations and the original structural calculations in a new cycle 2 SUPP. This is what is
meant by complete. The PLANS file should be handled in the same manner. No slip sheeting is performed in
Electronic Plan Check.

This way of handling electronic document management reduces processing time and thus processing fee costs
associated with assembly and disassembly of multicomponent documents. Preparation of resubmittals should be a
simple process of swapping out revised component documents and augmenting the file with new documents.
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Revisions (to issued permits):
One clear way of knowing that you need to apply for a revision is by asking yourself two simple questions.
Those questions are:

1. Am I seeking authorization to alter the scope of an Issued permit?
2. Am | expanding the scope of the previously issued permit?

If you answer yes to question 1, and no to question 2 you need to apply for a Revision. If your answer is that
you do not yet have an issued permit (no to question 1). Then you do not need to apply for a revision. Instead
you should refer to the section titled “When do | Resubmit and other details”, subparagraph “Mid plan
review scope revisions”.

If you answer yes to question 2 you most likely need a new separate permit. The reason for this, is that scope
expansions involve the need for additional field inspections and potentially other fees. Revision records do not
involve the collection of additional field inspection fees or other fees.

Now that we have established that you need to apply for a revision lets go over the steps.

e  First fill out the Deferred / Revision form (CDD-0269), adhering to the instruction sheet which
accompanies this form. This form should be included in the electronic APP file for the revision;

e Next, assemble a PLANS file comprised of the sheets effected by the revision. When submitting
revisions, you should only submit sheets which describe the scope of the revised work. This is distinct
from Resubmission which occurs after receiving plan review comments.

e If the scope of the revision requires support documents or revision of support documents such as
structural calculations, sprinkler calculations etc. those must also be submitted as the SUPP file;

e Submit the APP, SUPP and PLANS files to the City of Sacramento, Building Department.

0 Through the Citizen Portal — for more detail, refer to the section of this guide titled Online
Submission, Demonstrated. When you get to the application page of the online submission process
you will need to select the Deferred/Revision to issued permit option. Once this option is selected
another box will open requiring you to enter the record number of the permit being revised.

Revision Naming:

File naming of revision for initial submission can follow the same conventions outlined in the File Naming section of
this guide. Do not be concerned that the files will become confused with files submitted for the main permit. When
you submit your files, they will be assigned a unique record number which will clearly differentiate them from all
other submitted electronic files.

Revision Plan Set Construction:

The EPC process requires that complete sets be resubmitted from one cycle to the next. This policy can cause
confusion when applicants submit Revisions and deferred submittals. Sometimes the assumption is made that a
revision or deferred package must include the complete plan set for the permit being revised, not just the sheets
which describe the scope of the revision or deferred scope. If there are E, P, and M sheets for example the activity
must be targeted to Electrical, Plumbing, and Mechanical. Thus, if the scope of your revision to an issued permit only
involves electrical changes, only E sheets need be submitted.

Revision Fees:

Because revisions never expand the scope of a project but instead simply revise its scope they inherently have no
project value. The fees which are charged are limited to plan review, a technology recovery and intake fees. At the
end of the review process, when your revision has been approved all plan review hours are totaled, an invoice is
produced with the plan review hourly fees and the technology fee. This invoice is emailed to the applicant for
payment.
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Deferred Submittals:

Deferred submittals are portions of a scope of work covered by a building permit, which were not contained in the
plans submitted at the time of permit application. Deferred submittals must be approved by the Building Official or
his or her designee. All deferred items must be listed on the cover sheet of the plan set they were deferred from.

If the above steps were not followed when applying for a permit, then a deferred submittal should not be submitted.
Instead the scope must be submitted for review and approval as a new separate building permit.

Once you have confirmed the proper steps supporting deferred submittal were followed, proceed with preparation
of the electronic files for submittal.

e First fill out the Deferred / Revision form (CDD-0269), adhering to the instruction sheet which accompanies
this form. This form will become the electronic APP file for the deferred submittal;

e Next, assemble a PLANS file showing the scope of the deferred work. When submitting deferred submittals
only submit sheets showing the scope of the deferred work;

e If the scope of the deferred work requires support documents such as structural calculations, sprinkler
calculations etc. those must also be submitted as the SUPP file;

e Submit the APP, SUPP and PLANS files to the City of Sacramento, Building Department.

0 Through the Citizen Portal — for more detail, refer to the section of this guide titled Online
Submission, Demonstrated. When you get to the application page of the online submission process
you will need to select the Deferred/Revision to issued permit. Once this option is selected another
box will open requiring you to enter the record number of the permit being revised.

Deferred Submittal Naming:

File naming of deferred submittal for initial submission can follow the same conventions outlined in the File Naming
section of this guide. Do not be concerned that the files will become confused with files submitted for the main
permit. When you submit your files, they will be assigned a unique record number which will clearly differentiate
them from all other submitted electronic files.

Deferred Submittal Plan Set Construction:

The EPC process requires that complete sets be resubmitted from one cycle to the next. This policy can cause
confusion when applicants submit Revisions and deferred submittals. Sometimes the assumption is made that a
revision or deferred package must include the complete plan set, not just the sheets which describe the deferred
scope. If there are E, P, and M sheets for example the activity must be targeted to Electrical, Plumbing, and
Mechanical. Thus, if the scope of your deferred submittal to an issued permit only involves electrical changes, only E
sheets need be submitted.

Deferred Submittal Fees:

Deferred submittals do not have a project value the value is included in the main permit scope. The fees which are
charged are limited to plan review, a technology recovery and intake fees. At the end of the review process, when
your deferred submittal has been approved all plan review hours are totaled, an invoice is produced with the plan
review hourly fees and the technology fee. This invoice is emailed to the applicant for payment.
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Submittal Fees:

For a submittal to become an active Building Permit Application the city must receive payment for all required submittal
fees. Customers who submit at the counter will pay submittal fees just like a traditional paper submittal needing
plan review. Customers who elect to submit their project remotely will be sent an invoice which must be paid
before their project will become an active plan check activity. Payments can be made online or at the public
counter.
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Online Submission, Demonstrated:
The Citizen Portal can be accessed via links on our public website or by going directly to

https://aca.accela.com/sacramento . Once there you will see the screen below. To unlock access to EPC submission

you must login to the Citizen Portal. If you do not have a Citizen Portal account select the, New Users: Register for an

Account link.

Version 27

Building Planning Public Works  Operating Permit  General Property Info m

Advanced Search

Login

SACRAMENTO CITIZEN PERMIT PORTAL

Welcome to Sacramento's Citizen Portal! This portal allowsthe public to
check statuses, pay fees, and view details for permits.

User Name or E-mail:

If you would like to look up or pay fees for a specific record, select the
search or pay fees link under the appropriate program heading.

Some Portal functionality is only available after registering for an
account.

APPLICATION INSTRUCTIONS B Remember me on this computer

e frrrartban ma naccused

For instructions on preparing and submitting an application navigate to I New Users: Register for an Acoount
the program's web page below.

Planning Division: e-Planning, Online Payments

Building Division: Electronic Plan Check (EPC), Online Minor Permit
Program, Safety Inspection Requests, Inspection Scheduling, Online
Payments

Operating Permits: Mobile Food Vending, Cannabis Business Operating
Permit (BOP)

Public Works: Minor Encroachment, Major Encroachment, Transportation
Permit

Code Enforcement: Information on open and closed cases, Code
Enforcement, and Housing and Dangerous Building cases

FOR ASSISTANCE

+ Online Minor Permit Program email:
streamline@cityofsacramento.org
* Building Electronic Plan Check Process:
epcintake@cityofsacramento.org
* Planning Electronic Plan check or submittal:
planning@cityofsacramento.org
+* General Building Division question:
ezpermit@cityofsacramento.org
* Public Works:
« Minor or Major Encroachment Permits:
DE@cityofsacramento.org
« Blanket Encroachment permits (Utilities Companies
only): encroachments@cityofsacramento.org
e Operating Permits: businesspermits@cityofsacramento.org
+ Office of Cannabis Management: cannabis@cityofsacramento.org

If you cannot find the information you are looking for, please use the
City's updated search tool at https://search.cityofsacramento.org or call
311 or dial (916) 264-5011 outside the city limits.

Building Planning

O\ Search Permits or Submitals / Pay fees O\ Search Planning Applications / Pay Fees
G Search to Schedule an Inspection

Public Works Operating Permit

O\ Search Public Works Applications O\ Search for Operating Permits

General Property Info

O\ Zoning and Property Details

N
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Once logged in, select the Planning tab. Notice the Create Application Submittal option below:

| Planning I Public Works  Operating Permit  General Property Info  Home

‘ 9 Create Planning Application Submittal O‘ Search Planning Applications / Pay Fees

Selecting this link will bring you to the on-line application terms agreement. Agree to this to proceed.

Building m Public Works  Operating Permit  General Property Info Home

°Craate Planning Application Submittal O\ Search Planning Applications / Pay Fees

Online Application

Welcome to Agency’s Online Permitting System. Using this system you can submit and update information, pay fees. schedule inspections, track the status of your application, and print your final record
all from the convenience of your home or office, 24 hours a day.

Please "Allow Pop-ups from This Site” before proceeding. You must accept the General Disclaimer below before beginning your application.

General Disclaimer =
While the Agency attempts to keep its Web information accurate and timely,

the Agency neither warrants nor makes representations as to the

functionality or condition of this Web site, its suitability for use, freedom from
interruptions or from computer virus, or non-infringement of proprietary

rights. Web materials have been compiled from a variety of sources and are

[#! | have read and accepted the above terms.

Having agreed to the on-line terms agreement you will be brought to the screen below which enables you to select a
contractor’s license associated with your Citizen Portal account. It is not necessary for you to have a contractor’s license
associated with your Citizen Portal account to submit a project for EPC. If you do have a license associated and that license

will ultimately be the permit holder for the permit you are applying for you may select it now. If not simply select
None Applicable and then Continue Application.

Building m Public Works  Operating Permit  General Property Info  Home

oﬁeate Planning Application Submittal Q Search Planning Applications / Pay Fees

Select a License

Select a license for this record from the list below. The available permit record typels) is determined by the type of the license associated with your account.

* | icenses:

Mone Applicablew l
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On the next several screen you will be asked to all project specific information:

1-Site Information

You are now at the first of several screens which will allow you to enter information describing the location and
nature of the application you are applying for. The first piece of information which is necessary is the site location. If
there is a street address this should be entered using the

Street No. and Street Name boxes. If the property does not yet have a street address enter a parcel number, and
submit a complete Address Request Form (CDD-0104).

Applications for Master Plan Review where a building design is being reviewed independent of a specific property in
preparation for Production Permits, no address or parcel is required. For these jobs leave the Street No., Street
Name, and Parcel Number blank.

Building m Public Works  Operating Permit  General Property Info  Home

oCl'neate Planning Application Submittal Q Search Planning Applications / Pay Fees

Planning Online Submittal

1 Site Information 2 People 2 Application 4 Documents 5 Review 6

Step 1:Site Information > Location
* indicates a required field.

If propefty does not currently have a street address only populate the parcel field.

*Street No.: | Direction: |*Street Name: Street Type:  Unit Type: Unit No.:

—Selectw —Select- ¥ —Select- ¥

e
a

* Parcel Number: Legal Description:

| *

test

Owner Name:

Address Line 1:

Address Line 2: City: State: Zip:

--Selv

Save and resume later
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The owner section should self-populate when a street address or parcel number is entered. When submitting a master plan
this section can remain un-populated. To proceed with submission select the Continue Application button.

test

Owner Name:

CITY OF SACRAMENTO

Address Line 1:
S15ISTFLS
Address Line 2: City: State: Zip:
SACRAMENTO CA 95814
Save and resume later
2-People

The section allows you to select the Applicant. The applicant will generally be the project contact the City will communicate
with throughout the entire submittal, plan review, processing and permit issuance. Note that you can add multiple contacts
to your Public User account, to designate a particular project contact for your submittal.

Step 2: People > Contacts

*indicates a required field.

To add new contacts, click the Select from Account or Add New bution. To edit a contact, click the Edit link.

Select from Account

Save and resume later
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3-Application Details

In this section you can select the Application Type. This guide addresses only projects which either do not require a planning
entitlement or already have one, and construction plans and supporting documentation is ready to be submitted to the
building division for EPC.

Select Building Permit Submittal Clearance below. Complete Activity Type section, select the activity type which most
accurately describes the scope of your project and enter the Job Value. Type the Description of Work shown on your
building permit application (CDD-0200) into the scope of work box. This scope of work should match your project
scope from your construction plans.

APPLICATION TYPE

Planning Entitlement: )

[Bu ilding Permit Submittal Clearance: 61

FPre-zsubmittal Zoning Heview:

[A fist of Activity Types is only displayed when "Application for Building Permit Submitial Clearance” is selected.] Please select the most applicable Activity Type for your project.

Job Value: 1200000

Master Plan Review:

New Commercial Building: (D=
Addition o Commercial Building:

Initial Occupancy of Commercial Building:

Remodel and Change of Use of Commercial
Building/Space:

Remodel of Commercial Building:
Revision to Izsued Residential Permit:
New Residential Building:

Addition to Residential Building:
Remodel of Residential Building:

Deferred/Revision to Issued Commercial
Permit:

l SCOPE OF WDRKI

* Applicant Scope of Work: Construct a 2 story 6,330
sf retail building en
vacant lot, with 350 sf
patio & site work|
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Additions to Commercial or Residential Buildings:

Note that when your project scope is Addition to Commercial or Residential Building two additional Job Value fields must be
completed to break down the total project valuation for the addition and the remodel aspect of the proposed work:

ACTIVITY TYPE
[Alist of Activity Types is only displayed when "Application for Building Permit Submittal Clearance" is selected.] Please select the most applicable Activity Type for your project.
-

Job Value: 4300000
it -

Job Value for Addition Work: 4000000

- X

Job Value for Remodel Work: 300000

Master Plan Review:

New Commercial Building:

Addition to Commercial Building: v

Master Plans and Production Permits:

When a project involves the construction of the same building design (structure and floor plan) three or more times there
are plan review cost savings which can be realized by using the Master Plan Review Process. This process involves the
submission of the design for plan review and approval with no site-specific analysis. Once the Master Plan has been
approved Production permits can be issued for each instance in which the design will be constructed. Each production
permit pays only 50% of the plan review fees which would conventionally be charged.
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4-Documents

This section provides information on the types of documents that must be uploaded for each of the selections made in the
previous section. To proceed at least two pdf files must be uploaded: the APP (Building Permit Application) and the PLANS
(Construction Plans) file. In this guide only the Building Permit Submittal Clearance option is discussed.

Building Permit Submittal Clearance: For applicants who have prepared all building permit application materials and
need Planning to review them in order to submit to the Building Division. All projects require planning approval to
submit to the building division.

e Building Construction Plans

e Building Permit Application (CDD-0200)

e Building Supplemental

Step 4: Documents >Submittal Documents

*indicates a required field
_
Three Categories describe Planning applicants: Planning Entitlement, Building Permit Submittal Clearance and Pre-submittal Zoning review. These categories have distinct submittal requirements. Listed below, under the Application
Type names, is a list of the required documents for each category.

Planning Entitlement: For applicants who know their project requires a Planning entitlement.
Planning Plans (Site, Floor, Landscaping and Elevation plan sheets)

Planning Application (CDD-0063)

Planning Supplemental (see submittal Matrix on page 2 of the Planning Entitlement Application)

Building Permit Submittal Clearance: For applicants who have prepared all building permit application materials and need Planning to review them in order to submit to the Building Division. All projects require planning approval to
submit to the building division.

Building Construction Plans

Building Permit Application (CDD-0200)

Building Supplemental

Pre-submittal Zoning Review: For applicants in the early stages of project planning that need to know if an entitlement is required before preparing construction plans.

Planning Plans (Site, Floor, Landscaping and Elevation plan sheets)
Description of work Statement.

The maximum file size allowed is 1000 MB.
html:htm:mht:mhtml:exe:midi:lnk:zip:mp3:mp4:avi:mpg:mov:m4v:gif:rar:doc:docx:xlsx:xls:csv:wmv:rpt:txt:xml:rtf;wav:sql:wpd are disallowed file types to upload.

Name Type Size Uploaded Action

No records found.

—
Save and resume later

To upload your building submittal documents, select Add. Then locate the files for upload on your computer:

Organize * New folder > ™ @

File Upload X Adl~ Name - Status Date modified Type
At P

The maximum file size allowed is 1000 MB.

Bric F 123-MAIN-AVE-CVC1-APP [+ Adobe
are disallowed file types to upload BU! T 123-MAIN-AVE-CYC1-PLANS o

BvI TH 123 MAIN-AVE-CYC1-SUPP )

Adobe.

Adobe.

CD
D
cD
cD
cD
cD

co
cu
Do

Y <€ >

File name: | "123-MAIN-AVE-CYCT-SUPP" "12: ~

e
Cancel Open Cancel

A progress bar may appear while your files are being uploaded. You will see a confirmation of your upload with the
following screen. Select Continue finish adding these files to your submittal.
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File Upload

123-MAIN-AVE -CYCL-SUPP

The following page will allow you to select the correct document Category. Note that only the three types of Categories
listed above should be selected when requesting clearance to submit to Building. Don’t forget to Save the documents prior

to continuing the Application.

"+ Type:
Building Permit Application {CDD-02w

File:
123-MAIN-AVE-CYC1-APP.pdf
100%

* Description:
Building Permit Application, Agent for Owner Authorization Form

*Type:

Building Construction Plans

File:
123-MAIN-AVE-CYC1-PLANS pdf
100%

* Description:
Construction plans

*Type:
Building Supplemental

File:
123-MAIN-AVE-CYC1-SUPP pdf
100%

* Description:
Soils Report, Strdctural Calculations, Sprinkler Cutsheets, Water Supply Test Report

A confirmation of the successful upload will be displayed along with the document types uploaded as shown below.

Version 27 Revised 2/12/2020 Page 45 of 58



The attachment(s) has/have been successfully uploaded.
It may take a few minutes before changes are reflected.

123-MAIN-AVE-CYC1- Building Permit Application —
APP pdf (CDD-0200) 6.07 MB 12/24/2019 a
123-MAIN-AVE-CYC1- - >
SUPP.pdf Building Supplemental 1438 MB 12/24/2019 a
123-MAIN-AVE-CYC1- e . >
PLANS.pdf Building Construction Plans 64165 KB 12/24/2019 ad

Continue Application »
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5-Review.

You are now at the Review screen. All of the information you entered through the preceding screens can be edited
through the Review screen. If you need to edit any information select the Edit buttons provided next to each of the
section titles

Applications / Pay Fees

Planning Online Submittal

1 2 People 3 Application 4 Documents 5 Review 6 Record Issuance

Step 5: Review

Save and resume later

Please review all information below. Click the "Edit” buttons to make changes to sections o “Continue Application” to move on.

Record Type

Planning Online Submittal

300 RICHARDS BLVD

Parcel Number: 001-0210-045-0000
Legal Description: N LOT 2 PM 158-12

CITY OF SACRAMENTO
915 ISTFLS
SACRAMENTO CA 95814

Viktoria Handley

300 Richards Blvd
Sacramento, CA, 95811
United States

Mobile Phone:530-518-7282

E-mail-vhandley@cityofsacramento.org

APPLICATION TYPE -

Planning Entitlement: No
Building Permit Submittal Clearance: Yes
Pre-submittal Zoning Review: No
ACTIVITY TYPE

Job Value: 4300000
Job Value for Addition Worl: 4000000
Job Value for Remodel Work: 300000
Master Plan Review: No

New Commercial Building: No
Addition to Commercial Building: Yes

Initial Occupancy of Commercial No
Building:

Remodel and Change of Use of No
Commercial Building/Space:

Remodel of Commercial Building: No

Revision to Issued Residential Permit:  No

New Residential Building: No

Addition to Residential Building: No

Remodel of Residential Building: No

Deferred/Revision to Issued Commercial No

Permit:

SCOPE OF WORK

Applicant Scope of Work: Construct a 2 story 6,350 sf commercial retail building on a vacant lot, with 350 sf. patio & site development

The maximum file size allowed is 1000 MB.

are disallowed file types to upload.

Name Type Size Uploaded Action
B N Buldng Pamit Aplation .57 g ERYETD 3
;ﬁa“;:“"‘“'”m' Building Supplemental 1438 MB 1212412019 a
;ﬁ'ﬂ‘;ﬁ;"“'cvm' Building Construction Plans 64165 KB 1212412019 a

Save and resume later

6 — Record Issuance

Version 27 Revised 2/12/2020 Page 47 of 58



Once you select Continue Application, your Planning Application is created. Please, make a note of the Record
Number, which in this example is PLN-00052

0 Create Planning Application Submittal O‘ Search Planning Applications / Pay Fees

Planning Online Submittal

1 2 People 3 Application 4 Documents 5 Review 6 Record lzsuance

Step 6:Record Issuance

Your application has been successfully submitted.
Please print your record and retain a copy for your records.

Thank you for using our online services.

Your Record Number is PLN19-00052.

Receipt - You will need this number in case a refund is requested in the future.

Choose "View Record Details” to check status or make other updates to the record.

(You may need to re-enter the Record Humber if your connection is broken_)
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Checking the Status of Your On-Line EPC Submission:
Building Division intake staff has a goal of responding to all EPC submittals within 24 hours (not including weekends
or holidays). To check on the status of your submittal go to http://aca.accela.com/sacramento . It is not mandatory

that you log in to check on your submittal, but if you do login to your account the system will bring up all submittal
records you have created from your Citizen Portal account. Once you locate your record number either through
logging in or by the general search feature the following steps show how to check on your submission status online.

Your submittal record number should appear in the upper left hand corner of the screen. Your submittal records
status is shown below this number and is labeled with the title Record Status. The example record shown below has
a status of Submittal Incomplete this means that something about the submission package must be revised for it to
be possible to move forward.

Accessing Submittal Correction Comments:

Select the arrow just to the left of the words Record Info. A drop down will appear, select the Intake Review & Plan
Review choice. The Intake Review & Plan Review section will open. Within this window select the arrow next to EPC
Intake. Next, select the arrow next to Assigned to TBD. Here you will find comments detailing how your submittal
must be/revised for resubmission.

G Planning  Public Works  Operating Permit ~ General Property Info Home

o\ Search Permits or Submitals / Pay fees m Segrch to Schedule an Inspection

Record SUB-1512463: |
Commercial Plan Review Submittal
Record Status: Submittal Incomplete

Record Inch Payments Education Assats Custom Component

Record Details n or for more options, click Record Info drop-down menu above. Before you can schedule inspections, you will need to

you do not have an account, you can register for one by clicking the 'Register for an Account’ link at the top.

Review

Intake Review & Plan ]

Related Records

Documents

Schedule Inspection
{will occur 7:30a -
3:00p - Inspector will

call before armival) Project Description:
EPC Submittal - New Commercial Building - Construction
Valuation Calculator of 10,000 sq. Ft. Office Building and associated site
N T LR S development improvements including a parking lot and
nevada/city, CA, 95817 lighting.

Maobilg Phone:916-123-7891
encrgachmentpermit@gmailcom

» More Details

Intake Review & Plan Review

v EPC Submittal

Marked as Cycle 1 Submittal Incomplete on 10M16/2015 by GO

Due: 10/15/2015

|

Plans file must be bookmarked. Currently not all pages are bookmarked. APP file your: your APP file contains your structural calculation they must

Comment: be submitted in the SUPP file. Please revise your submission and upload corrected files. Thanks you, Intake staff.
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Resubmitting your Submittal, Demonstrated:

Once you have revised your submittal package in accordance with the submittal correction comments. You will need
to go to the Citizen Portal as described in the section above titled Checking the Status of Your On-Line EPC
Submission, with one difference. When uploading new files you must login to your Citizen Portal account. If you do
not log in you will not be able to upload new files. Once you have logged in and located your submittal record select
the Record Info link to open the drop down menu. Within the drop down menu select the Documents choice. This
will open the Documents section for this specific record. Select the Add button.

NG Planning  Public Works  Operating Permit = General Property Infe Home

Q\ Search Permits or Submitals / Pay fees m Search to Schedule an Inspection

Recorq SUB-1512463
Commercial Plan Review Submittal
Record Status: Submittal Incomplete

Record InD Payments Education Assats Custom Componant

Recard Details n or for more options, click Record Info drop-down menu above. Before you can schedule inspections, you will need to

Intake Review & fan you do not have an account, you can register for one by clicking the "Register for an Account’ link at the top.

Review

Related Records

Documents

Schedule Inspection
(will occur 7:30a -
3:00p - Inspector will

call before arrival) Project Description:
EPC Submittal - New Commercial Building - Construction
Waluation Calculator of 10,000 sg. Ft. Office Building and associated site
B Tt L development improvements including a parking lot and
nevada city, CA, 95817 lightimg.

Mobile Phone: 916-123-7891
encroachmentpermit@gmail com

Documents

The maximum file size allowed is 1536 MB.
html e mht; mhtmbexe midi;link:zip; mp3; mpd;avi;mpg:mov.mdv; gif:rardoc;docixlsx xls csvy wmvs rpt et xmbrtf wavisql,wpd are disallowed file

types to upload.
Name Record ID Record Type Entity Type Type Size Uploaded Acti
g‘}gf:g';_ﬂ' SUB-1512463 Eﬁt:':n"i";;lcial Plan Review  p. cord Permit Documents  3.96 MB 10/15/2015 4
3%3?5;;5;;' SUB-1512463 E&:‘;‘n"‘iﬁ;fhl Plan Review  p.cord Specifications 6.16 MB 10/15/2015 a
I517-36TH-ST- g 151543 ~ Commercial Plan Review  p. .y Plans/Drawings  26.88 MB 10/15/2015 a

CYC1-PLANS. pdf
7 /|
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You will see the familiar File Upload Window. Select the Add button.

File Upload *

Next, navigate to your revised PDF files. Don’t worry about changing the file naming. Intake staff will be able to
differentiate between the initially submitted files and your revised files by date. Select the files either one at a time
or all at once using the Ctrl key. Select the Open button to initiate the Upload process.

.. v Computer » Removable Disk (G:] » SUBMITTAL

G-

Organize MNew folder

Name Date modified

30 Favorites

Bl Desktop | 1517-36TH-ST-CYCL-APP 10/6/2015 8:52 PM

Adobe Acrobat D...

4,055 KB|

& Downloads = ‘E 1517-36TH-ST-CYC1-PLANS 10/6/2015 9:02 PM

Adobe Acrobat D...

21,524 KB|

% Dropbox ‘@ 1517-36TH-5T-CYCL-SUPP 10/6/2015 9:07 PM

Adobe Acrobat D...

6,304 KB |

1= Recent Places

4l Libraries
@ Documents
J’ Music

[E5] Pictures

B videos

File name: "1517-36TH-ST-CYC1-SUPP" "1517-36TH-5T-CYC1-APP" "1517-36TH-ST-CYC1-PLANS"

+ [AllEiles

I Open

!

Once the progress bars show 100% next to each of the electronic files being uploaded select the Continue button to
complete the upload process. Intake staff will be electronically alerted of your resubmittal. Returnto the steps
outlined in the section titled Checking the Status of Your On-Line EPC Submission over the next 24 hours (not

including weekends) to monitor the progress of your submittal.

File Upload

The maximum file size allowed is 1536 MB.

are disallowed file types to upload.

1517-36TH-5T-CYC1-APP pdf 100%
1517-36TH-5T-CYC1-PLANS pdf 100%
100%

1517-26TH-5T-CYC1-SUPP pdf

Remove All
Cancel

*

htmlhtm;mht:mhtmlexe;midi;ink:zip;mp3:mp4:avi:mpg;mov:mdv;gif.rar; doc:docx s xls;csvwi
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Submittal “Accepted”:

Once you return to the Citizen Portal and the record status is shown as Accepted, you will know that your submittal
package met all of the submittal requirements. At this point in the intake process staff will create a COM-, RES- or
MP- record for your project and emailing you an invoice with the remaining submittal fees based on your projects
scope and value. Payment of this invoice will'trigger your application being moved into formal plan review.

10 Planning Public Works  Operating Permit  General Property Info Home

O\ Search Permits or Submitals / Pay fees m Search to Schedule an Inspection

Record SUB-1512463:

Commercial Plan Review Submittal
Record Status
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Paying Submittal Fees

You can pay submittal fees in three possible ways, on-line (using a credit card or an electronic check), via standard
mail (with a check) or in person at the public counter.

To pay on-line go to the Citizen Portal. From the home tab, select the Search Permits or Submittals / Pay Fees link.

Building Planning Public Works  Operating Permit  General Property Info

Advanced Search

Building Planning

(-J\ Search Permits or Submitals |/ Pay fees ] Q. Search Planning Applications / Pay Fees
Lm Search to Schedule an Inspaction

Public Works Operating Permit

O\ Search Public Works Applications Q. Search for Operating Permits

General Property Info

O\ Zoning and Property Details

Enter the COM-, RES-, FPP- or MP- in the Permit Number box and then select the Search button to move forward.

General Search

Permit NMumber: Project Name:

Start Date: ) | End Date:

02/08/2017 02/05/2020

Street No.: Direction: () Street Name: /) Street Type:
From - To —5Seleck- W --Select-- ¥
Parcel No.:

License Type: State License Number:

--Select— b

First: Last: Name of Business:

» Search/Additional Criteria
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Select the blue arrow on the Payments tile. Then select the Fees link. This will display the invoiced submittal fees. To
pay the fees select the blue Pay Fees link.

Record COM-1512471:
Commercial New Building
Record Status: Formal Review

Record Info Payments Conditions e Education More...
— This record was Iocl 2015,
(%) Condition: School F ity: Required
Total Conditions: 2 1TUSt Account
Information
To schedule an Inspectio_________ ¢k Record Info drop-down menu above. Before you can schedule inspections, you will need to

log into your account. If you do not have an account, you can register for one by clicking the ‘Register for an Account’ link at the top.

Fees

Qutstanding:

Date Invoice Mumber Amount

10/20/2015 443744 51041717
10/20/2015 443745 5$73.00 -

Total outstanding fees: 5$10,490.17

To mail in payment, mail a check made out to the City of Sacramento for the amount of owed submittal fees with
the invoice number and permit record number:

City of Sacramento, Building Division, EPC Intake
Attention: (the COM-, RES- or MP- number here)
300 Richards Blvd, 3™ Floor
Sacramento, CA 95811

Be sure to include a copy of the invoice.

To pay fees in person at the public counter, bring payment to 300 Richards Blvd, 3™ Floor between 9:00am &
4:00pm Monday through Friday.
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Plan Review Verify and Processing:

When all disciplines have approved the project, it enters the “Verify and Processing” stage. During this stage, all
approval stamps will be consolidated on to the most current set of submitted plans. For example, if a project
took three cycles to gain all plan review discipline approvals any of the reviewers which approved in earlier cycles
will be asked to approval stamp the most current set. Once the most current set is fully stamped final fees will be
calculated, an email will be sent to the building permit applicant. This email will communicate the final fees and
outstanding conditions which must be resolved prior to permit issuance. Following the instructions outlined in
this email will result in the permit achieving a “Ready to Issue” status. Once the permit activity has achieved the
“Ready to Issue” status all that remains for the applicant to do is pay the invoiced fees. Having resolved all
outstanding conditions and paid the associated permit fees the project will become issued.

Permit Issued:

Once the permit is issued the approved plans and supplementary documents will be made available to the
permit holder or original applicant via the Citizen Portal. They should be downloaded, printed and kept at the
jobsite during construction. See the section below titled Downloading Issued plans for a description of how to
download the approved issued plans.

The final approved PDF set, called the “Job Set” will only have read and print privileges. Staff will not change the
permit status to “Issued” until all fees are paid in full.
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Downloading Issued Plans:

The process of downloading your issued plans and supplementary files through the Citizen Portal should begin by
you confirming that the COM-, FPP- or RES- is in an Issued status or if the application is for Master Plan Review that
the MP-is in a complete status. As previously demonstrated above in, Online Submission, Demonstrated this can be

accomplished by navigating to the CDD Citizen Portal at https://aca.accela.com/sacramento. To check the status, you

will not have to log in, but to download the files you will, so go ahead and enter your User Name or Email associated
with your account, and your password.

If you are a contractor, only now becoming involved in the project and you do not yet have a Citizen Portal account
you will need to create one so that the system can identify you. The SUB- record will need to be updated to show
you as a contact or licensed professional. This can be coordinated by emailing CDD-
processing@cityofsacramento.org or if your projects value is over $1 million email your project manager directly. In

this email indicate that when the project was initially submitted the contractor was yet to be determined (TBD), but
that you have now been established as the contractor and thus need to be installed as a contact on the SUB- record
which will be used to distribute the issued plans. Be sure to clearly communicate the email address which is
associated with the Citizen Portal account you have established. You should also be the contractor listed on the
Building Permit Application CDD-0200) as the permit holder.

When the applicant is sent the email during processing which conveys the final fees due, and any outstanding
unresolved conditions which must be dealt with. The applicant will need to respond with instructions to add you as a
contact or licensed professional. It is only necessary to establish an ACA account with an associated California
contractor’s license if you plan to apply for on-line minor permit otherwise a basic ACA user account will suffice.

Once the preceding measures have been put in place and the individual wishing to download the issued plans is
appropriately associated with the SUB- record. That individual should log in using their User Name and Password on
the Citizen Portal page at: https://aca.supp.accela.com/SACRAMENTO/Welcome.aspx

Following successful login, the screen will change slightly to what is shown below. You will be able to see your User
Name at the top of the page. You can locate all of the records created with your user account, or those to which you
were given access by the department by navigating to the Building tab:

Planning  Public Works  Operating Permit  General Property Info  Home

eﬂpﬂyfor Minor Permits/Safety Inspections Q\ Search Permits or Submitals / Pay fees

Records

Showing 1-10 of 100+ | Download results | Add to collection

Record

Date Permit Number Ty Description Address Status Action
[ D Construct a 50000 commercial retail B RICLIARUS L )
01272020 SUB-2000022 Plan Review buildi SACRAMENTO CA Submittal Pending Review
Submittal ek 95811
Commercial Z00 RICHARDS BLVD,
0171772020 SUB-2000015 Plan Review Mew commercial building SACRAMENTO CA Submittal Pending Review
Submittal 25811
Cerrze Construct a new 5,000 sq ft single UL
01/15/2020 SUB-2000013 Flan Review <tory office builds N onsaqvacaﬁ ot SACRAMENTO CA Submittal Pending Review
Submittal — = " 00000
" 7

Below this list is also a General Search screen which allows you to search by Permit/Record Number, or Street No.
and Street Name. After making entries select Search.

Once you get to the specific record you are looking for the record number will be displayed in the upper left hand
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corner of the screen. Next, you will need to open the dropdown menu under Record Info and select Documents

Record SUB-1900486:
Residential Plan Review Submittal
Record Status: Accepted

Record Info Paymeants

Record Details n or for more options, clicl

irmziva Fevicwr & Pl you do not have an accour

Review

Related Racords

Schedule Inspection
{will cccur 7:30a -
3:00p - Inspector will
call before arrival)

Documents

Valuation Calculator

The Job Copy files, PLANS and SUPP should display in the column labeled with “Name”. The names of these files
should be blue. This indicates that they are downloadable. If they are not shown in blue text you may have not been
designated as a contact or licensed professional for this file and should contact the processor of your COM-, RES- or
MP- file. This would be the person who emailed you the final invoice. You can also email

epcintake @cityofsacramento.org and type the SUB-# and “l need access” in the subject line.

Assuming everything is in order you'should see your two jobcopy files, PLANS and SUPP. Click directly on the file
names individually. Depending on the configuration of your computer system some type of progress bar will appear
asking if you would like to open the file or save the file. After saving the file you will have possession of your issued
PLANS and SUPP files. They have been encrypted to allow printing and saving but no alteration.

Documents

The maximum file size allowed is 1536 MB.
html;htm;mhtmhtmbexe/midi;inkzip:mp3;mp&:avi;mpg:mov:mdv; gif rar;doc;docixisicxls;csv; wmv rpt tet xmbrtf; wav: sql;wpd are disallowed file
types to upload.

Name Record ID Record Type Entity Type Type Size Uploaded Action

12666- _ Commercial Plan Applications
CPppar | SUB-1512463  LOTERECER T Record . 396ME  10/20/2015 | o
~ Commercial Plan Applications
 por| SUB-1512463  LOTREER TOD Record . 616MB  10/21/2015 | o
21000112256672013- .
08-27SAFCA-DIE_5-  SUB-1512463  COmmercialPlan Record Plans/Drawings ~ 13436KB  10/21/2015  |o
1-3015.PDF Review Submittal

Frequently Asked Questions:
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The following information is provided to help answer any unresolved questions related to submission or
processing an application using the Electronic Plan Check Submittal. Additional Questions not answered below
may be addressed to the Building Helpdesk, at ezpermit@cityofsacramento.org, or by our Electronic Plan Check
intake team at epcintake@cityofsacramento.org.

Q. How can | check on the status of my application?
A. Applicants or any member of the public can check the status of a project by visiting:

https://aca.accela.com/sacramento/Default.aspx, and selecting the Building tab followed by “SEARCH BY
RECORD INFORMATION” and entering the project number (See Example 1.1).

Q. How can | create a scaled PDF?

A. When plotting your electronic plans use the built in scale parameters to set the final scale of the plan.
If your software does not have this function, try running a keyword search on the internet for
“creating a PDF to scale”, or contact your software manufacturer.

Q. | cannot reduce my file size below 50 or 200 Megs, how can | reduce the size of my PDF files?

A. When initially plotting your plans make sure the PDF creation settings are Black and
White only (no gray scale or color) and at 300 DPI. This simple adjustment generally will decrease the
file size and after using Adobe 10 Pro “optimize” function most files will be well under 50 Megs. The City
has received 130 page plans that were reduced to 28 Megs by the use of this method.

o

What types of plan prints are required on the jobsite once | have downloaded the issued sets?

A. The City requires color plans on the job site. This provides an additional level of verification that the
“Job Copy” is official. This does not preclude you from making black and white copies for sub-
consultants or for bidding purposes.

Q. | cannot upload files during the resubmittal phase of plan review. Why does the system keep saying “An
error has occurred, Action Cancelled”?

A. This error occurs when you try to upload files to the RES, MP- or COM- record number rather than the
SUB- record. The record which is used to convey files back and forth, whether it be uploading or
download is the SUB- record.

The City of Sacramento reserves the right to modify any Electronic Plan Check review policies and procedures at
any time.
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